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This document is an introduction to Microsoft Access 2010, running under Microsoft Windows 
XP. For further information see Microsoft Access 2010 - An Intermediate Guide.  

 

Introduction 
A database is a computer program for storing information in an easily retrievable form. It is used mainly to 
store text and numbers (for example, the Library catalogue, which includes the author, title, class number 
and accession number for each book).  

Most modern databases also allow the storage of other types of information such as dates, hyperlinks, 
pictures and sounds. As well as being able to store data, a database allows you to select information quickly 
and easily (for example, a list of the books written by a particular author or those on a certain subject). Finally, 
it may allow you to produce printed summaries (reports) of the information selected.  

When setting up your own database, it is important to plan its use in advance. This is particularly important if 
you are setting one up which will be used by other people. Among the things which you should consider are:  

 What information you will need to store  

 What information you want to get out  

 Who the data is intended for and how other users will use it  

 Whether you want to restrict access to parts of the data to some users only  

 Who is allowed to add or change data  

 If your data refers to actual people, it may need to be registered under the Data Protection Act 

Ńthough this doesn’t apply to a personal database of family and friends) 

Although you can change the specifications of your database as you develop it, you will save yourself a lot of 
work if as much as possible is planned in advance.  

Microsoft Access is a relational database management system (which allows you to link together data stored 
in more than one table). It is fully supported by IT Services and is available for personal purchase as part of the 
Ultimate Steal and for departmental installation under the Microsoft Select Agreement.  

Starting Microsoft Access 
If you are using an IT Services machine, login as usual by entering your username and password. Then, to 
start up the program:  

1. Open the Windows Start button and choose All Programs  

2. Select Microsoft Office then Microsoft Access 2010 

Tip: If you right click on the Microsoft Access entry in the menu and choose Send To then Desktop (create 
shortcut) you’ll have an icon on the Desktop for future easy access. You can also do this with any Access file. 

The Access Screen 
On entering Access you are presented with a screen showing available templates, which have been designed  
to help you create your own databases. You can search for further templates at Office.com. These templates 
can be quite helpful for particular applications but you nearly always have to tailor the database produced to 
your own requirements. 

You can also either create a new blank database (without help) or open an existing one. In this course you are 
going to use an existing database, to see how it is set up and how it can be used.  

http://www.reading.ac.uk/web/files/its/AccessInter2010.pdf
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1. Click on Open (or simply press <Ctrl o>) 

2. An Open window appears – scroll down on the left and click on My Computer then on Data (D:) 

3. Double click on the folder called Training to open it 

4. Click on example2010.accdb from the list which appears and press <Enter> or click on [Open] 

Note: For those using these notes on a computer not run by IT Services, the example file can be downloaded from 
the link provided at step 4 above.  

Users are welcome to take a copy of the example file if they want to practice.  

The Navigation Pane 

 

In the next screen, the Navigation Pane appears on the left. This controls navigation within a particular 
database. A database is made up of several objects, grouped into a single file. This database has been set up to 
show All Access Objects which currently exist in this database, but there are other types of object as well 
which do not currently appear. You will be meeting some of these later in the course.  

The arrow at the top of the pane (to the right of All Access Objects) lets you select specific types of object. 

http://www.reading.ac.uk/web/files/its/example2010.accdb
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The full list is:  

 Tables - hold the raw data  

 Queries - extract part of the raw data to produce dynasets - dynamic sets of data which can change 

each time the query is run (to reflect any changes to the data in the tables)  

 Forms - user-friendly layouts to display data on the screen (either in a table or from a query)  

 Reports - output files, ready for printing  

 Pages - for creating/editing WWW pages  

 Macros - lists of commands to perform particular functions  

 Modules - programs which expert users write in a programming language called Access Basic to 

perform tailor-made functions not generally available  

The objects are accessed from the Navigation Pane. Pages, Macros and Modules are not dealt with in this 
course. As you use the different objects, the tabs on the Ribbon change appropriately.  

1. Click on a double arrow on the right to show or hide the objects in a particular group 

2. Click on the single arrow at the top of the Navigation Pane to view further display options 

Part 1: Using an Existing Table 
Begin by investigating the table named students. This contains data relating to imaginary students in a 
fictitious department in the University, but it could equally be members of a club or just information about 
your friends and relatives. 

1. Select the students table then press <Enter> (or double click with the mouse) to open it 

A new pane opens on the right showing the data set out in a table. This method of display (known as 
Datasheet View) shows the data in columns and rows, similar to a spreadsheet. There are a number of entries 
(records), one for each student, which each take up one line or row of the table. For each student, various 
items of data are recorded in columns - each column contains one variable (or field). On the top of the table 
is a tab, which provides easy access when you have more than one object open. 

 

Immediately below the data is the status bar, which shows you are positioned at Record 1 (of 390). The 
current record has a slightly darker background, while the column on the far left is yellow-orange (the current 
field has a coloured border). You can move the indicator down to the next record by clicking on the button 
immediately to the right of the number 1 on the status bar. The next button to the right takes you to the end 
of the table - click on this and you should be at Record 390. Matching buttons on the left take you back a 
single record and back to Record 1 - try out these too. You can also move up and down using the arrow keys 
on the keyboard. The scroll bar down the right edge of the table window moves the display up and down.  

Another scroll bar is provided at the foot of the window for moving to the left and right when the records 
extend over more than one screen. To move from field to field across a record, use the <right arrow> and 
<left arrow> keys or <Tab> and <Shift Tab>. The <End> key takes you to the last field, the <Home> key to 
the first. <Page Up> and <Page Down> take you up and down a screen, while <Ctrl Home> and <Ctrl 
End> take you to the first field of the top record and final field of the last record, respectively.  

View:  or  

To see exactly what each record contains and how it has been set up:  

2. Click on the [View] button (the first on the Home tab) – a Design tab is added to the Ribbon 
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The Table Design pane lists the field names, indicates their data types and also shows the field properties. The 
screen appears as below:  

 

The fields (and properties) are as follows:  

 StudNo: A text field containing each student's personal id, as allocated by the University Registrar's 

Office. Text fields are the commonest type of fields and can be used to store any characters 

(letters, punctuation, numbers etc). Numbers should be stored as text if not being used in 

calculations. This field is set up to hold up to 10 characters and a Caption is used to expand the 

field name. This number uniquely identifies each student - the Required property has been set to 

Yes and Indexed is set to Yes (No Duplicates). This field has also been used to set up a Primary Key, 

which you will learn more about later.  

Tip: It's good practice not to include spaces in field names (or in the names of tables / queries / forms / etc). 
Instead, make use of Captions to expand the field name (to include any spaces). Not only do you have less 
characters to type but it makes manipulation of the data much easier if you find you need to use more 
advanced database features.  

3. Press <down arrow> to move to the next field (then repeat this for each field): 

 Surname: A text field containing the Family Name of each student. This field is required, can hold 

up to 25 characters and is Indexed as Yes (Duplicates OK) 

 Title: Another text field but this time for up to 4 characters. Here, we know the possible values 

(Mr/Mrs/Miss/Ms) and can set up a Validation Rule to check that the data entered is correct - if it is 

not, the Validation Text is displayed. A Default Value (Mr) has also been set  

 FirstName: Another text field for student's first name - up to 20 characters  

 OtherInitials: A text field for any other initials - up to 6 characters  

 EntryYear: A number field recording the student’s year of entry. Numbers can be stored using 
different field sizes; here, an integer is used - see the Appendix for a full explanation. This could also 

be stored as a text or date/time field, depending on how it is to be used. The Default Value is set to 

the current year using built-in Functions. 

 Hall: Another text field where the values are known (there are only certain Halls of Residence) so a 

Validation Rule has been set - up to 15 characters. A Default Value (Private) has also been set  
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 Userid: This is the student's computer username, which can also be used for the student’s email 

address (see next field) - a text field for up to 8 characters  

 Email: The student’s email address, calculated from the Userid – you’ll learn more about this later 

 Tutor: The student's tutor - again a text field for up to 20 characters  

 Option: A number field which points towards different optional course modules the student can 

study. As the number of options is small (and always +ve), the field is stored as a byte. A slightly 

different Validation Rule is used to check the data entered  

 DOB: The data type here is Date/Time, which has been set up in Medium Date format. Note that a 

Caption is used to expand the field name.  

 Address1: First line of the student's home address - a text field storing up to 50 characters  

 Address2: Second line of the student's home address - a text field storing up to 20 characters  

 PostCode: The student's home post code - a text string storing up to 10 characters  

 Phone: The student's home telephone number - note that even though this is a number it is 

stored as text (you won't be doing any mathematical calculations with it!)  

 Overseas: A Yes/No (or logical) field storing whether the student is from an EEC country or not. The 

Default Value is set to No.  

 Notes: For any other pieces of information - for longer pieces of text, a memo is used  

 Photograph: Digital data (eg a passport photograph) are stored as OLE Objects  

Other data types exist which are not included here, namely: currency, autonumber, hyperlink and attachment 
(see the Appendix for further details).  

Tip: Note that the student's surname is stored separately from the first name (similarly each line of the 
address is in a separate field). Information should always be stored in its component parts. You can then, for 
example, sort by surname then first name, or reference the students formally (ie Mr X) or informally (by their 
first name). You will see later how to combine this data into a single field, if you need to.  

To close the Table Design pane and return to the top of the datasheet:  

4. Click again on the [View] button - note how the icon on the button changes as you move between 
Design and Datasheet view  

Searching for a Particular Record 

Find:  

To search for a particular record (ie down a field), you should first move to the field you want to search: 

1. Press <Tab> to move to the Surname field  

2. Click on the [Find] button on the right hand side of the Home tab on the Ribbon (or press <Ctrl f>) and 

a Find and Replace window will appear  

3. The cursor is already positioned in the Find What: box - type in smith 

The default options should already be set correctly. The Look In: box shows the search is restricted to the 
current Surname field (alternatively, you can search the whole table). In the Match: box, you can choose to 
match the Whole Field, Any Part of Field or the Start of Field. Search: is set to All records.  

The other options are Up and Down. Match Case lets you distinguish capitals from lower case (if you need to). 
Finally, Search Fields as Formatted is useful for finding data as displayed (a date format, for example). Note that 
you also have access to a Replace tab for editing data.  

4. Press <Enter> for [Find Next] and the search should be carried out  
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5. Press <Enter> again and another Smith will be found  

6. Keep pressing <Enter> until you get the message that the search item is not found  

Obviously, this is not a very elegant way of retrieving information from the database - but it works! To close 
both the warning message and Find window:  

7. Press the <Esc> key twice or click on [Cancel] (or on the red [Close] button) 

8. Finally, press <Ctrl Home> to move back to the first record (or use the first button on the record 

indicator bar)  

Sorting 
The records, as you have seen them so far, are shown in the order that they were first entered into the 
database - as the data came from the Registrar's Office, it is in Student Number order. For this reason, it 
wouldn't have been easy to search for Smith simply by scrolling through the records (and imagine trying to 
find a book in the Library if they were all listed by their date of purchase!). If the data is sorted, however, then 
you can scroll through the records to search for a particular one.  

Quick Sort 

Ascending:    Descending:    Clear All Sorts:  

To sort any field into alphabetical/numeric order, a quick sort facility is provided. First, you have to move to 
the column on which the sort is to be based:  

1. Press <Tab> to move to the Surname field  

2. Click on [Ascending] in the Sort & Filter group on the Home tab of the Ribbon 

The names of the students are now in alphabetical order. Note that only the screen display is sorted - the 
records are still stored in the order in which they were typed, and they always will be.  

3. Use the [Remove Sort] button to reset the data to its original unsorted order  

Changing the Default Display Order 
If you want to keep the new display order for the next time you open the table, all you have to do is close the 
table, saving the changes to its design. Try this next: 

1. Move to the field you want sorted (eg Surname)  

2. Click on [Ascending] (or [Descending] if you want the data in reverse order)  

3. Close the table by clicking on its [Close] button 

4. Save the changes to the table design when asked - press <Enter> or click on [Yes]  

5. Now press <Enter> again to reopen the table - you should find it in the new order  

BEWARE: it's very easy to accidentally save unwanted changes to the table design (if you perform a quick sort 
on another field, for example). Sort on the correct field again (then close and save) to get back your original 
table order. 

Sorting in a Query 
Sorts can also be carried out and stored in a query. Moreover, within a query you must set an explicit sort 
otherwise the records are displayed in their original order of entry. Queries are particularly useful where you 
have more than one field you need sorted - a simple quick sort only lets you sort on the one field (you can't 
for example sort by surname then firstname). By using a query you can produce a display sorted on any of the 
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fields and can even create complex sorts within sorts. You will be looking at queries shortly, and carrying out 
sorts in them, so there is no need to carry out an example here.  

Indexes 
An index can be likened to an index in a book (this adds just a few extra pages but is invaluable if you want to 
look up something). In a database it is used to speed up searching, sorting and grouping data - one should be 
set on any field used frequently in these ways. Access records the sort order in a hidden object so that it 
doesn't need to repeat the sort each time. Indexes also perform a second useful function in that they can be 
used to guard against duplicate data entry. They are always used when a field is set up as a Primary Key. Try 
setting up an index on another field:  

1. Click on the [View] button to switch back to Design View  

2. Note that the StudNo field already has an index - set to Yes (No Duplicates). As this is used as the 

Primary Key, it must have this setting  

The Surname field has an index of Yes (Duplicates OK). This field is frequently used for sorting and duplicate 
values are allowed - as you have already seen with Smith. Try setting an index on Hall - another field likely to 
be used in sorting/selecting:  

3. Click on the Hall field and, using the list arrow, set Indexed to Yes (Duplicates OK)  

4. Next click on the Userid field and note the index here is set to Yes (No Duplicates). The values in this 
field should be unique and the index will ensure this  

5. Click on the [View] button again to switch back to Datasheet View - when asked, press <Enter> or 

click on [Yes] to save the changes to the design of the table  

Adding, Editing and Deleting Records 

New Record:   Delete Record:  

Whenever you make any changes (additions, deletions or edits) to a table, it is the original data file that you 
are altering. Unlike most other applications, a database does not make a working copy of the file first. For this 
reason, it is essential to keep a back-up copy of your file (to which you can always return), just in case you 
make mistakes when carrying out amendments.  

To add a new record to the database, use the [New] button (on the status bar or in the Records group on the 
Home tab of the Ribbon) – you can also press <Ctrl +>. New records are always added at the end of the 
existing data. As soon as you start to type, Access creates a new empty record (marked with an asterisk), 
while the current record indicator changes from an arrow to a pencil:  

1. Click on the [New] button - you should now be on Record 391  

2. Type in a number for the StudNo (type in your own or just 99) then press <Enter> (or <right arrow> 

or <Tab>) to move to Surname  

3. Type in your own name then move to Title (press <Tab>, <Enter> or <right arrow>)  

4. Repeat step 3 until you have filled out most of the record (at least the columns up to Hall) 

Note that some fields already have a default value. To change a value in a field you simply type in a new one. 
Note also that some fields (eg Hall and Option) can only accept certain values, others (eg StudNo, Surname 
and FirstName) cannot be left blank.  Calculated fields, such as email, cannot be edited. 

The Photograph field can hold a picture. The best way to add one is via the Clipboard (ie Copy and Paste). If 
you right click on the field and choose Insert Object... then it may appear as an icon which you then have to 
double click to open. As pictures cannot be displayed in tables anyway, don't try filling out this field here.  
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Note: The best method for entering data is via a form, which you will be meeting later.  

To delete the current record (in this case your own):  

5. Click on the [Delete] button below [New] on the Ribbon and choose Delete Record (alternatively, 
select the record by clicking at the far left then simply press the <Delete> key) 

Deleting records from a database is potentially very dangerous as they are erased once and for all, hence you 
are given one final chance to change your mind:  

6. Press <Enter> for [Yes] to confirm the deletion 

Note that you can't now use [Undo] to recover the record. If you have several records to delete:  

7. Using the mouse, point to the left-hand edge of the first record to delete - you will find that the mouse 

cursor changes to an arrow  

8. Hold down the mouse button - the record is marked - then drag through the records required  

9. To delete them, press the <Delete> key (or use the [Delete] button)  

10. When asked to confirm the deletions, this time click on [No] and the records will reappear  

Note: Records must be next to each other in order to delete them (you cannot use <Ctrl> click like you can 
in other Microsoft software, though <Shift> click can be used to select a block of records). You will see next 
how to select a subset of non-contiguous records, which you could then delete.  

Selecting Records 
Databases offer you the facility of extracting sub-sets of records according to some pre-set conditions. In the 
Library, for example, you can search for the books written by a particular author or those dealing with a given 
subject. Access offers you two methods for selection, Quick Select using a Filter and Selection using a Query.  

Quick Select 

Selection:    Toggle Filter:    Filter:   

Simple selections can be made directly on the table itself, using a filter. Access 2010 provides two 
mechanisms for this, as you will see:  

1. Press <Ctrl Home> to move to the first record (press <Enter> first if this didn’t workń 

2. Move across to the Hall field - to find all the students living in a particular hall  

3. Using the <down arrow> key, move to a record showing the Hall of Residence you require (or click on 

it using the mouse or you could use [Find] to search for a particular Hall)  

4. Click on the [Selection] button (in the Sort & Filter group) and choose Equals… 

Note that at the bottom of the screen it says Record 1 of XX and Filtered. To turn off the filter:  

5. Click on the highlighted [Toggle Filter] button (below [Selection]) 

You can also filter on part of a field - for example, you might want all students with a May birthday:  

6. Double click on any occurrence of May in the DOB field (or drag through the word) to select it 

7. Click on the [Selection] button and choose Contains ķMayĸ to carry out the filter 

If you now also wanted to find the first year students born in May Ńwe’ll use the other method of filtering this 
time):  

8. Click on the [Filter] button at the top of the Year of Entry field  

9. Untick the Select All check box and tick the year required (here, 2011) – press <Enter> for [OK] 
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Note that this method is more flexible in that it allows you to set more than one criterion: 

10. Click on the [Filter] button again and tick a second year – press <Enter> for [OK] 

You now have the May birthday students in two of the years. If you wanted the July birthday students instead, 
you use the Date Filters option followed by All Dates in Period in the Filter button window. Note that you 
can also open the filter selection by clicking on the filter icon shown on the right at the top of each column.  

Having made your required selection, there are several things you might want to do next. For example, you 
might want to delete these records - even though they are not next to each other in the full dataset, you 
could drag through them here and delete them as before (but don't do so here).  

Another thing you might want to do is to print off the data. However, you probably wouldn't want all of the 
fields, so you'll see next how to hide unwanted columns.  

Changing the Fields Displayed 
Tables often contain a lot of data, only some of which may be required. You can control which fields are 
shown and which hidden. Here, you may want just the student name and hall:  

1. Right click on the StudNo column heading and choose Hide Fields 

To hide several adjacent columns in one go:  

2. Click on the Userid column heading  

3. Scroll to the right then hold down <Shift> and click on the Photograph column heading 

4. Right click on the selected columns and again choose Hide Fields  

If you want to change the order of the fields on the screen, you can either use cut and paste or, more simply, 
drag and drop. Both these techniques should be familiar to the Microsoft Office user. To list the students 
starting with their full name (including title) in the correct order:  

5. Click on the Surname column heading to select the column  

6. Move the mouse cursor back into the column heading, hold down the mouse button then (with the 

button still depressed) drag the column to the right to a position immediately before the Year field  

7. Release the mouse button to drop the field in its new position 

Note: you are only changing the screen display - the data is still stored in its original order.  

Finally, you might want to print your list. First, it's a good idea to preview it:  

8. Click on the File tab, choose Print then Print Preview  

You will notice that Access automatically adds a header and footer to your page, which you may or may not 
want. Normally you would now print your list, but here:  

9. Click on [Close Print Preview] on the far right of the new Print Preview tab to turn off the preview 

To redisplay any of the hidden fields:  

10. Right click on any column heading and choose UnHide Fields 

11. Click in the box against the required hidden column to redisplay it then press <Esc> for [Close] 

Advanced Filters 
The relationship between queries and filters is a very close one. You can in fact save a filter as a query by 
turning on the advanced filter option. This can be a useful aid in designing a query. As an introduction to 
queries, save the current filter (students born in May who came in a particular year):  

1. Click on the [Advanced] button in the Sort & Filter group and choose Advanced Filter/Sort...  

A Filter Design pane appears. This is very similar to the Query Design pane, which you will be using next. 
Examine how the criteria have been set up.   
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2. Move to the File tab and choose Save – the Save As Query dialog box appears  

3. Save the filter as MayBirthdays (press <Enter> for [OK]), then [Close] the filter window  

4. Close the students table - don't save the changes to the design (click on [No]) 

Tip: The simplest way to redisplay all the fields if some are hidden is to close the table without saving the 
changes to its design. When you reopen it, it will appear in its original format.  

To rerun the filter:  

5. Select MayBirthdays from the new Queries categoryin the Objects list and press <Enter> to open it  

You’ll find that all the fields are displayed. You’ll see later how to specify particular fields in a query. 
6. End by closing the query - click on its [Close] button  

Once a filter has been saved as a query, it's easy to modify its design if necessary.  

Using a filter in this way is straightforward but a little limited. To do more complicated selections you have to 
use a Query. Queries also offer various other facilities, including sorts within sorts. In fact you may always want 
to view your data through a query – here, for example, you might want to see the students listed 
alphabetically by Surname then by FirstName.  

Sorting in a Query 

Run:  

To introduce you to queries (which may look a little complicated at first, but which are in fact very easy), try 
carrying out a sort within a sort. There are two ways to start a query:  

 You can choose [Query Wizard] on the Create tab of the Ribbon to get help   

 You can choose [Query Design] on the Create tab  

The Query Wizard isn’t very useful here, so try the second method instead:  

1. Move to the Create tab on the Ribbon then click on [Query Design] in the Queries group  

2. In the Show Table window, select the students table then press <Enter> to [Add] it 

3. Press <Esc> to [Close] the Show Table window 

Note: If you ever wanted to add a different table, click on the [Show Table] button in the Query Setup group 
on the new Query Tools Design tab on the Ribbon.  

 

The Select Query pane may look a little confusing, but in fact it's very simple to use. The cursor should be 
flashing in the Field: row in the lower part of the screen waiting for you to define the fields to be displayed. 
Earlier, you sorted the students table by students’ surnames but you couldn’t then also sort by their first name. 
Here in a query, you can:  
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4. Click on the list arrow on the right of the Field: cell and choose students.* 

The asterisk notation means all the fields in the students table (if you only want certain fields displayed you 
must choose them individually). If you were to run the query as it stands, you would see the data in its 
original unsorted format Ńie the sort you set when the table is opened isn’t carried across – instead you have 
to set up explicit sorting in the query). 

5. Click on the list arrow in the Field: cell in the second column and choose Surname 

6. Repeat step 5 in the third column but choose FirstName 

7. Move down to the Sort: (third) row and type a (for Ascending) in both columns 2 and 3 

8. In the Show: (fourth) row, untick the check boxes in both columns 2 and 3 (you can click anywhere in 

the cell) - if you don't, the names will appear twice as they are already included in students.* 

9. To carry out the query, click on the [Run] button on the far left of the Ribbon (or you can use [View] to 
move from Design View to Datasheet View) 

You should find that the students are now listed in their correct order (look at the Smiths) and that this 
query should act be used whenever you want to look at the complete set of data. 

10. Click on the query’s [Close] button  

11. When asked, press <Enter> or click on [Yes] to save the query  

12. Save the query as SortedStudents - press <Enter> or click on [OK]  

Selection using a Query 
Next, you are going to repeat the filter you carried out earlier to list all students from a particular hall. This 
time your new query will be making use of the fact that you already have the students sorted by name (a 
query can be based either on a table or another query): 

1. Click on the [Query Design] button on the Create tab 

2. In the Show Table window, click on the Queries tab and select the SortedStudents query 

3. Press <Enter> to [Add] the sorted students then press <Esc> to [Close] the Show Table window 

4. Set the Field: in the first column to Surname and that in the second column to FirstName 

You now need the Hall field in a separate column to set up the selection criteria. Another way to fill up a field 
is to double click on it in the field list in the top half of the Select Query window. You can try this next:  

5. Double click on the Hall – it should be added to the next empty column in the query 

6. Move down to Criteria: in column 3 and type the name of the required hall - eg Wessex  

7. To carry out the query, click on the [Run] button on the far left of the Ribbon (or use [View] to move 

from Design View to Datasheet View) or right click on the Query design and choose Datasheet View 

The difference between this query and the earlier filter is that you can save it directly for future use.  

8. Click on the query's [Close] button  

9. When asked, press <Enter> or click on [Yes] to save the query  

10. Save the query as Hall - press <Enter> or click on [OK]  

Note: You can't give a table and query the same name.  

Now try re-running the query:  

11. Double click on the Hall query in the Objects list - you have your results again  

Parameter Queries 
The selections you have carried out so far have only met fixed criteria - in this case: Show me the students who 
live in Wessex (or whichever) Hall. With a query, however, you can change the criteria each time you run it by 
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making it a parameter query. The design is very similar to what you have already seen except that instead of 
setting a fixed criteria, Access asks for the information at run time. Modify the Hall query to do this:  

1. With the Hall query still open, click on the [View] button to change to the Design View  

2. Click in the Criteria: field in the third (Hall) column and <Delete> the current criteria  

3. Type in a new criteria saying: [Which Hall?]  

Note: square brackets tell Access that this is a question, to be displayed at run time.  

4. Click on the [Run] button (or on [View] to switch to Datasheet View)  

5. When asked the question Which Hall? type in the required hall of residence - eg Sibly  

6. Press <Enter> or click on [OK] and the query will be run 

Normally, you would run the query each time from the Objects list (or from a user-friendly interface - a form 
called a switchboard). Here, however, to run the query again:  

7. Click on the [View] button to change to the Design View  

8. Click on the [Run] (or [View]) button again  

9. Type in the name of a different hall - eg Windsor - and press <Enter> or click on [OK]  

As you can see, this query is much more useful than when it only worked for a fixed hall. The same 
mechanism is used when you look up a book in the Library. Here, the query picks up the parameter from a 
box on the screen Ńwhere you have typed in the author’s name or the subject you are searching forń. 

More Complex Queries 
Next, try some more complicated queries. What if you want to have an alternative criteria in a parameter 
query? For example, you might want a list of students living in either one hall or another. To do this, you have 
to set up criteria on two different lines.  

1. Click on the [View] button to change to Query Design  

2. In the second line of the Criteria: in column 3, type: [or?] for a second question  

3. Click on the [Run] button (or on [View] to switch to Datasheet View)  

4. When asked Which Hall? type in the name of the first hall - eg Wantage (press <Enter>)  

5. When asked or? type in the name of another hall - eg Wessex (press <Enter> )  

6. You now have the students from both halls - [Close] the query, saving the new design  

You have seen how to match values in a query but you can also use criteria such as greater than, less than, not 
equal to, between one value and another, or matching part of a field. For example, how do you set up a query 
to pick out just the female students? The answer is that you can use a special notation called Like.  

The Like notation indicates that the words which follow must be embedded within the data in that field for a 
record to be selected - wildcards (* or ?) can be used to denote characters which may precede or follow the 
required text. ? represents a single character whereas * represents any number of characters. For example, 
Like C* could be used to give you all the students with names beginning with the letter C, while Like *son 
would match students whose names end with son. For the female students:  

1. Click on the [Query Design] button on the Create tab  

2. In the Show Table window, click on the Queries tab, select SortedStudents and [Add] it 

3. Press <Esc> or click on [Close] to close the Show Table window  

4. Set the Field: in the first column to SortedStudents.* (ie double click on the *) 

5. Set the Field: in the second column to Title  

6. In Criteria: in the second column type: *s (this covers Miss, Ms and Mrs) and press <Enter> (Access 

automatically changes this to Like "*s" for you)  

7. Turn off Show: by unticking the box 
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8. Click on the [Run] button to run the query - or switch to Datasheet View 

To set up a second condition on this subset of data (eg female students who have a particular tutor) is very 
easy. Whereas alternative conditions are set up on different lines, simultaneous conditions must be set up on 
the same criteria line:  

9. Click on the [View] button to move back to Design View  

10. Set the Field: in the third column to Tutor  

11. Turn off Show: by unticking the box  

12. In Criteria: in the third column, top line, type: [Which Tutor?] - or set a fixed value  

13. Click on the [Run] button to run the query - or switch to Datasheet View 

14. When asked Which Tutor? type in the name of a tutor (eg Foot) - press <Enter> for [OK] 

15. [Close] the query, saving it as Females  

Adding New (Calculated) Fields 
Earlier, you did a very simple selection to show just the student's name and hall of residence. One fault with 
the original example was that the students' names (first name and surname) were printed in separate 
columns. In a query you can calculate a new field, joining these together:  

1. Click on the [Query Design] button on the Create tab of the Ribbon 

2. In the Show Table window, select the Students table and [Add] it - press <Esc> to [Close] the window  

3. In Field: in column one, type: FullName: FirstName & " " & Surname (don't forget the 

space between the double quotes) - press <Enter>  

Tip: You should always use an ampersand (&) rather than plus (+) sign when joining text together. Though 
both appear to work, plus signs can occasionally cause problems.  

4. Set the Field: in the second column to Hall  

5. Set the Field: in the third column to StudNo 

6. Set the Field: in the fourth column to Surname and set Sort: to Ascending and turn off Show: 

7. In the fifth column, repeat step 6 but set the Field: to FirstName 

8. Click on the [Run] button (or on [View] for Datasheet View) to run the query 

9. Double click on the dividing lines between the column headings to widen the FullName column 

10. Right click on the StudNo heading and choose Hide Fields (this field is needed later but doesn’t need 
to be displayed here) 

11.  [Close] the query, saving it as Names  

A calculated field also occurred in the original students table – you can add such fields both to queries and 
tables. To see how it was calculated 

12. Open the Students table and click on the [View] button to move to Design View 

13. Click on the Email Field Name and take note of the Expression in the Field Properties 

14. You’ll find the email address is defined as: [Userid] & “@reading.ac.uk” 

Note that the Result Type of this email field is Text and not Hyperlink. This means it has not created an active 
hyperlink Ńie you wouldn’t be able to click on it to send a messageń. 

15. Finally, [Close] the students table 

Tip: When creating complicated calculations, it’s useful to evoke the Expression Builder. This appears if you 
right click in the Field: row (or, indeed in Criteria:) and choose Build.... There’s also a [Builder] button on the 
Ribbon. You then have access not just to the field names but also to built-in functions. Even more importantly, 
a Criteria: can be set to pick up values held on  forms. 
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Using a Form 
The next object to investigate is a Form. Forms offer a friendly way of viewing the data in that they show a 
single record at a time. Forms can also be used to display results from queries. They are also used to facilitate 
data input. A form has already been set up for the students table:  

1. Double click on the students form in the Objects list (or click on it and press <Enter>) to open it 

 

A user-friendly screen is displayed, with a title at the top and the fields listed and boxed. The buttons work as 
they did before, allowing you to move around, add new records, delete records, filter, sort and search etc.  

2. Move to the Surname field (press <Enter>, <Tab> or <right or down arrow>)  

3. Click on [Ascending] on the Home tab on the Ribbon to sort the forms into alphabetical order  

4. [Close] the form then reopen it - the sort order remains, as it did with the table 

Forms also provide short-cuts to data entry, including letting you select from a list of valid values. Use this 
form to type in your own information again:  

5. Click on the [New] button in the Records group on the Home tab  

6. Fill in the fields with your own information, as you did before  

7. In the Title field, select the required title using the list arrow  

8. In the Hall field, start typing the name of the hall and watch Access select from the list of values  

9. Note that once you’ve filled in the Userid field, the Email field is automatically calculated 

10. The Tutor field also has a list arrow attached  

11. The Overseas field appears as a check box - click on it (or press <spacebar>) to set it on if necessary  

12. In the Notes field, type several lines of text (type rubbish text, if you like) and watch how the box 

accommodates it - press <Tab> to move to the next field (the <down or right arrow> keys simply 

move through the text, while <Enter> gives you a new paragraph!)  

13. For a Photograph, right click inside the box and choose Insert Object… then Create from File and 

Browse for the file.  

If you haven't got a picture file handy, press <Alt PrintScreen> to dump the current window then press 
<Esc> followed by <Ctrl v> to [Paste] it from the Clipboard . 

Tip: As was mentioned earlier, when you insert a picture file in Access it often appears as an icon. Insert it into 
Word or PowerPoint instead, then Copy and Paste into Access and it appears okay. 

14. End by deleting your own record - click on the arrow attached to the [Delete] button and choose 
Delete Record then press <Enter> for [Yes] (or click on [No] if you really want to keep it)  

15. Finally, press <Ctrl Home> to move back to the first record 
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Form Design 
Though forms are very easy to use, they are not that easy to design from scratch. Fortunately, Access has 
wizards to do most of the work for you. To modify a form, you view the form design:  

1. Click on the [View] button (or right click and choose Design View) 

Note that Access provides you with three new tabs on the Ribbon to help you with the design. You are not 
going to modify the design of this form - you will see how to later, in Part 2 of these notes. For the moment:  

2. Click on the [View] button to move back to Form View 

Filter by Form 
If you want to select a subset of the records using a filter, you can still use the [Selection] button as before. 
This isn't very convenient, however, if you want to base the filter on information not displayed on the current 
form. Here, you might want to search for students living in Wessex Hall (which isn't on the current record). 
You can do this using the [Filter] button as before, but Access also provides a special filter for use with forms. 

1. Click on the [Advanced] button and choose Filter by Form  

2. Click on the list arrow attached to the Hall field and select Wessex  

3. Click on the [Toggle Filter] button - you should have just 9 records (use <Page Down> see them) 

4. Click on the [Toggle Filter] button again to see all the records  

Though this exercise could have been carried out using the [Filter] button, this next one can’t: 
5. Again. click on [Advanced] and choose Filter by Form – your previous filter is shown 

6. Click on the list arrow attached to the Title field and select Mr 

7. Now click on the Or tab at the bottom of the filter pane for a second filter 

8. Select a Title of Miss and a Hall of Windsor 

9. Click on the [Toggle Filter] button - you now have 19 records (press <Page Down> to see them) 

10. Close the form by clicking on its [Close] button 

Note that you can also use [Filter by Form] on a table (a blank record appears for you to type in the criteria). 

Using a Report 
The fourth object button in the Navigation Pane is Report. This allows you to create (and store) reports which 
can then be printed. A students report has already been prepared (you’ll see how to create one  later):  

1. Double click on the students report in the Objects list (or click on it and press <Enter>) to preview it 

2. The mouse button acts as a zoom facility - position the magnifying glass over a particular piece of text 
and click on the mouse button to magnify it or use Zoom in the bottom left corner of the screen 

Note: if you use Zoom, this will alter the magnification level setting for the mouse button. 

3. Use the page selection buttons at the foot of the Preview window to move to other pages (<Page Up> 
and < Page Down> stop working temporarily if you change the Zoom level) 

To see how the report is designed:  

4. Right click on the report and choose Design View  

Note how similar Report Design and Form Design are - you have matching Design tabs on the Ribbon to draw 
the various components. Again, you will see how this is done later. Reports can also be viewed in Report View: 

5. Right click on the report and choose Report View  

6. Scroll down (or use <Page Down>) to see the results 

7. Close the report - click on its [Close] button 
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Part 2 : Creating a New Table 
In this next section you will be creating your own table (and form). You will be typing in a couple of records 
and then retrieve some more from a file.  

Designing the Table 
As much as possible of a table design should be done in advance on paper. Here, however, you will be 
creating the table on the screen so that you can see the stages as they are implemented. The table you are 
going to create contains information about the Halls of Residence at the University. In Part 3 of these notes, 
you will see how to link this information to the data in the students table:  

1. Click on the Create tab on the Ribbon  

The Tables group on the left offers you various alternative methods to create a new table:  

 Table creates a blank datasheet for you, with an ID field and an Add New Field column. As you enter 

data into this column, another Add New Field appears and the first column is relabelled Field1. 

Access recognises the type of data entered and automatically allocates a Data Type to it (eg if you 

type a date, the field will be set up as a Date/Time field). To rename the fields, double click on each 

column heading and type in its new name  

 Table Templates has predefined Sample Tables (Contacts, Tasks, Issues, Events, Assets). Each sample 

table has many fields, which you may or may not want to include in your own table design. 

Templates have the disadvantage that they sometimes try to be too clever and are very much 

geared to the American market (eg Addresses have States, not Counties)  

 SharePoint Lists - SharePoint is not supported by the University, so this is irrelevant 

 Table Design lets you do everything yourself, from scratch  

It’s important to understand the fundamentals of table design, so choose that method:  

2. Click on the [Table Design] button 

3. The first field is for the name of the hall - type in Name and press <Enter> 

A warning message appears telling you that Name is a reserved word and could cause problems later. Other 
reserved words include Date and Year. There’s a problem here in that it’s necessary for this field to be called 
Name in order to import the Halls’ data in the later exercise. Indeed, it's important that you name the fields 
exactly as specified in these notes for this exercise to work.  

4. Press <Enter> for [OK] to cancel the warning and accept the field name 

5. The Data Type is Text by default - press <Enter> as this is what you want for this field  

6. The Description is optional - type in Name of Hall of Residence if you want  

7. Move down to the Field Properties  

Tip: Key <F6> can be used to Switch panes - or you can use the mouse. 

8. Set a Field Size of 15 and press <Enter> 

If you need to increase the field size at some time in the future there should be no problem (any existing data 
stays exactly the same). However, if you ever choose to decrease it then you could lose some data. This is 
called truncation. 

9. Set up a Caption of Name of Hall then Required to Yes  

10. Set Indexed to Yes (No Duplicates) - it's important to put an index on this field since it will be used to 
link up the students’ data and it also insures that the data for a particular hall is not entered twice  

11. Move to the second row - use the mouse this time 

12. Set the Field Name to Warden and the Data Type to Text  
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You could now fill in the Description and set some Properties but, to speed things up, just leave the settings for 
this (and subsequent fields) as they are.  

13. Press <down arrow> then <back arrow> to move to the third field  

14. Set the Field Name to Phone and the Data Type to Text  

15. Press <down arrow> then <back arrow> to move to the fourth field  

16. Set the Field Name to Road and the Data Type to Text  

17. Press <down arrow> then <back arrow> to move to the fifth field  

18. Set the Field Name to Town and the Data Type to Text  

19. Press <down arrow> then <back arrow> to move to the sixth field  

20. Set the Field Name to Rooms, the Data Type to Number (for a Description add Number of rooms in 

the Hall) and the Field Size property to Integer  

21. Move to the seventh field  

22. Set the Field Name to Meals, the Data Type to Yes/No , add Are meals provided? for a 

Description and the Default Value property to Yes  

Note: The Lookup tab in the Field Properties allows you to set up a different Display Control on a form or table. 
For a Yes/No field, this is set to Check Box but can be Text or Combo Box:  

23. For the Meals field, click on the Lookup tab and set Display Control to Text Box 

Setting up a Primary Key 

Primary Key:  

Whenever you design a new table, it's a good idea to set up a Primary Key on one of the fields. Primary Keys 
help Access uniquely identify each individual record in a table and hence work more efficiently. If a table 
doesn't contain a unique identifier then Access will ask to set up an ID field for you. Here, the Halls of 
Residence table already has a unique field - the name of the hall:  

1. Click on the Name field (row 1)  

2. Click on the [Primary Key] button - a key symbol appears in the field indicator column  

3. Click on the [View] button to move to Datasheet View  

4. When asked (press <Enter> for [Yes]), save the table as HoR - press <Enter> for [OK]  

You’ll find you have an extra column labelled Add New Field. To hide this: 

5. Right click on the column heading and choose Hide Fields 

You could now type in your data, if you wanted to. Using a datasheet isn't very friendly, however, so try 
setting up a special data-entry form. A form gives you more control over what data is entered and can be 
designed to cut down on typing mistakes, as you saw with the students form.  

Creating a Data Entry Form 
There are two simple ways of creating a form; you can either use a Form Wizard or AutoForm. AutoForm is a 
very quick and easy way to produce a form - it does so at the click of a button:  

1. With the HoR table still open, click on the Create tab then on [Form] - the form appears 
instantaneously in a new window  

2. Click on its [Close] button to Close the form - don't save it this time (click on [No]) as you will be 
creating the form using a Wizard next  

The Form Wizard is equally easy to use and offers you various additional options.  
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3. Still on the Create tab, click on [More Forms] then choose Form Wizard 

As you already had the HOR table open, that is chosen automatically. If you start up the Wizard without a 
table or query open (or if you wish to base the form on a different set of data) then you would select it here. 

You are now asked which fields you want to appear on your form (here you have the choice - AutoForm gave 
you them all). As it happens, for a data entry form, you need all the fields:  

4. Click on the double arrow [>>] to move them all (alternatively select individual fields in the order you 

want and use the [>] button) - press <Enter> or click on [Next>]  

5. Choose a layout for your form (explore the alternatives, if you like); Columnar is best so choose that 

then press <Enter> or click on [Next>] 

6. Set a style for your form - choose None (press <Enter> or click on [Next>])  

7. Add a title - type Halls of Residence (press <Enter> to [Finish]) 

The form is now opened for you to use. As it stands it is neat and simple, but a little boring - in fact it's almost 
exactly the same as that produced using AutoForm. To improve it  

8. Right click on the form (or use the arrow attached to the base of the [View] button) and choose 

Design View to move to Design View 

Forms have three (sometimes more) sections - a header, footer and the detail. The data itself is entered into 
the detail section; the header and footer can be used for titles etc. To add a footer:  

9. Position the mouse over the bottom border of the Form Footer - the cursor should change shape to a 

double-headed arrow. Hold the mouse button down and drag the border down one unit (there's a 

scale on the left-hand side)  

10. Click once on the [Label] tool in the Controls group - the mouse pointer now has an A attached  

11. Move the pointer into the form footer (top left corner) and click once  

12. A small label box is drawn - type your form footer: The University of Reading  

13. Press <Enter> and the label box is completed  

14. Change the [Font Size] (eg to 14 point) and click on [Bold] to make the title more imposing  

To display the enlarged label: 

15. Right click on the label box and choose Size then To Fit  

16. Right click on the label box and choose Font/Fore Color - pick a colour to apply to your footer  

17. Right click on the header background (away from the label) and choose a Fill/Back Color  

Note: If you wanted to add a picture to the form (eg the University identity) then simply click on the [Logo] 
tool, choose where you want the picture, click the mouse button then browse for the required picture file. 

You can also amend the design of a form (just the position of objects and their colour) in Layout View:  

18. Right click on the tab at the top of the form and choose Layout View  

19. Click on the detail area on the far right – the detail area is outlined in orange 

20. Use the [Fill/Back Color] button on the Ribbon  to change the colour of the detail background 

Tip: Use the [Format Painter] to copy the colour scheme of one label or text box to the others - this speeds 
things up and gives a better overall design. Double click on the button if you want to paint the format to more 
than one object (then click on it again to turn it off when you have finished). 

21. Press <Ctrl s> (or click on the [Save] button) to save the changes to the design of the form - the name 

of the form is picked up automatically as Halls of Residence  

22. Click on the [View] button to move to Form View  

The form is now ready for you to type in the data. Note how large the boxes are for the Warden, Phone etc 
compared to the Name box. This is because you left the Field Size at 255 (whereas for Name you set it at 15). 
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Entering Data Using the Form 
You are now going to use the form to enter a couple of data records:  

1. For the first record, type in the following:  

Name: Wessex (and press <Tab> - if you press <Enter> by mistake, press <Backspace>) 
Warden: Dr R.P.B. Smith (<Tab>) 
Phone: x8643 (<Tab>)  
Road: Whiteknights Road (<Tab>)  
Town: Reading RG6 6BQ (<Tab>)  
Rooms: 196 (<Tab>)  
Meals: the option box is already set on for Yes  

2. Press <Tab> or <Enter> to move on to the second record, which is as follows:  

Name: Windsor (and press <Tab>)  
Warden: Prof A.L. Jones (<Tab>)  
Phone: x8800 (<Tab>)  
Road: Upper Redlands Road (<Tab>)  
Town: Reading RG1 5JL (<Tab>)  
Rooms: 353 (<Tab>)  
Meals: again, the option box is already set on for Yes  

This is all you are going to enter explicitly; the remaining records are going to be imported from a data file 
created using another package.  

3. Close the Form window by clicking on the [Close] button (save any changes to the design) 

4. Also, close the HoR table by clicking on its [Close] button (saving any design changes) 

You may be wondering why the records you entered weren’t shown in the table Ńremember, the form is used 
as a friendly way to enter data into the tableń. The reason is that the screen wasn’t refreshed. To see the data: 

5. Double click on the HoR table in the Objects list then [Close] it again once you have seen the data 

Importing Data 
Access allows you to bring in information from other sources - this is called importing. Databases vary on 
how they bring in the data and on which sort of files they can import. If you have a really large dataset, it is a 
good idea to try importing a small section to a new table first and only if that works successfully to try to 
import it all.  

Access can import data in various formats, including Dbase (another widely-used database) and HTML (from 
web pages). Microsoft Excel spreadsheet files can be imported directly. Here, the data has been saved as tab 
separated values, which is a standard format which any spreadsheet (or indeed word processor) should be 
able to produce. Other basic formats include comma separated values and just plain text. One thing to note 
when importing a file is that the first line may contain headings - Access has an option to cope with this and 
can use them for field names.  

To add the data to an existing table (or create a new table) from a file:  

1. Move to the External Data tab then click on [Text File] in the Import group 

2. Click on [Browse] to search for the required file 

3. Check that the current directory is set to Training on the D: drive (if using a lab PC; if not, the file can 

be downloaded from the WWW via the hyperlink at step 4)  

4. Select the file called halls2010.txt then press <Enter> to [Open] it  

The default is to create a new table, but here: 

5. Choose the Append a copy of the records to the table option and select HoR – click on [OK] 

http://www.reading.ac.uk/web/files/its/halls2010.txt
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6. The Import Text Wizard now starts up. This has several stages, as follows: 

a. Choose whether the data is Delimited (eg tab, comma or space) or Fixed Width (where extra 

spaces have been used to line up the data in columns) - press <Enter> or click on [Next>] for 
Delimited  

b. Choose the delimiter (here, Tab is correctly chosen) and whether or not the First Row Contains 
Field Names (here, it does, so click to set it) - press <Enter> for [Next>]  

Tip: If you are adding to an existing table and the first row doesn't match the table field names 
then import them as an extra record, which you later delete 

c. The final step of the wizard confirms the table name (or asks you for a one if creating a new table) 
- press <Enter> for [Finish]  

d. Don’t bother saving the import steps – press <Esc> for [Close] 

You should have imported 11 new records – if a message appears press <Enter> for [OK] to cancel it.  

7. Double click on the HoR table in the Objects list to see the new records  

8. Resize the columns by double clicking on the column heading dividers  

9. End by closing the table - click on its [Close] button, saving the changes to the layout of the table 
(press <Enter> for [Yes])  

Note: you can also export data from Access for another package via the Export buttons on the External Data 
tab. Amongst the formats available are Excel, Word and Text File (suitable for many applications, including SAS, 
SPSS and Minitab).  

Part 3: Relating Tables Together 
A relational database management system lets you store information in many tables which can then be 
linked together. This is particularly useful when you have information which is either heavily duplicated or 
sparse (many records having empty fields). This improves both performance and scalability. 

For example, if you have an inventory of equipment, it's better to record information about the suppliers (the 
name, address, phone/fax numbers, contact etc) in a separate table. Then, in your inventory, you need only 
record the name of the supplier to find out the other information. As each supplier will be supplying several 
pieces of equipment, this avoids massive data duplication.  

It's the same situation here with the students. There is no need to store information about Halls of Residence 
for each student - that can be picked up from the HoR table. You'll see next how this is done. The aim of the 
exercise is to create a list of students, living in hall, such that you can send a letter to them to their University 
address.  

1. Move to the Create tab and click on [Query Design] in the Other group on the right of the Ribbon 

2. [Add] both the HoR and students tables and the Names query - press <Esc> or click on [Close]  

You next have to join the three tables together on common fields. Joins can be created between tables when 
you design the database (in a special Relationships window), or made in a query (in which case they only apply 
to that particular query).  

Tables are automatically joined in a query if two fields have the same name. Here, the StudentID field in the 
Names query has been joined to the equivalent field in the students table. The other common field (the Hall of 
Residence) is called Hall in the students table but Name in the HoR table and has not been linked. In this case 
you have to create the join manually by dragging the field name from one table/query over to the 
corresponding name in the other table/query.  

3. Position the cursor over the Hall field in the students table  

4. Hold down the mouse button and drag the field over the Name field in the Halls table  

When you release the mouse button, a join line appears. If you made a mistake, simply click on the join line to 
select it then press <Delete> and try again. Now you need to set up your query:  
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5. In column 1, set the Field: to FullName from the Names query (double click on it) 

6. In column 2, set the Field: to Hall from the students query  

7. In column 3, set the Field: to Road from the HoR table  

8. In column 4, set the Field: to Town from the HoR table  

9. Click on [Run] to run the query - you should find 265 records are displayed (if you spelt Wessex and 
Windsor correctly - the 125 students living in private accommodation are excluded)  

10. Click on the query window's [Close] button, saving it as Addresses  

Relationships 
To save creating relationships each time you create a query, the tables and some existing queries can be 
linked and held as a hidden object in the database. This is done through the Relationships dialog box: 

1. Move to the Database Tools tab on the Ribbon then click on [Relationships] in the Show/Hide group 

2. Click on the [Show Table] button in the Relationships group on the new Relationships Tools Design 
tab if the Show Table dialog box isn’t displayed Ńuse this to add further tables/queries if you need to) 

3.  [Add] both the HoR and students tables and the Names and Addresses queries as you did in the 
previous exercise - press <Esc> to [Close] Show Table  

4. Drag the Hall field in the students table over the Name field in the Halls table – an Edit Relationships 

dialog box appears: 

 

Various additional options can be set but some of these are only available if Referential Integrity exists. This 
happens if all the possible values in the field in the main table Ńthe student’s hallń are present in the matching 
field (the Hall name) in the related table. That isn’t true here as many students are in Private accommodation.  

Referential Integrity can also be used to protect data. You wouldn’t be able to remove a Hall from the HoR 
table as records in the SortedStudents depend on it. If you were to turn on Cascade Delete Related Records 
then you could delete a Hall ... but then all the students in that hall would be deleted from the database. This 
isn’t a good idea here but would be if a customer of a business were to die. His related records (eg orders) 
could be deleted at a single stroke, just by deleting his record. 

5. Click on [Create] to create the link 

6. Repeat steps 3 and 4 to join the StudNo in the students table to that in the Names query 

7. Repeat steps 3 and 4 to join the FullName in the Addresses query to that in the Names query 

8. [Close] the Relationships – answer [Yes] to save the changes to the design 

9. Start setting up the Addresses query again – you’ll find the join links appear automatically 

10. [Close] the new query – don’t bother saving it, click on [No]  
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Creating a Report 
Earlier you viewed an existing report; now, try to generate some yourself. Reports are saved within the 
database - you can then modify them at some later date if you need to tidy up the layout, for example. Note 
that you can also export data to Word or Excel via Export on the External Data tab.  

Access gives you the opportunity of designing your own reports from scratch (using Design View), however, 
unless you are an expert, don't even attempt this. It's much easier to use AutoReport or a Report Wizard and 
then modify the design if you need to.  

Using AutoReport 
Begin by creating a report for the HoR table using AutoReport.  

1. Click on the HoR table in the Objects list – there’s no need to open it 

2. Move to the Create tab and click on [Report]  

Access shows you the results in Layout View. The dashed lines show the page breaks, but it’s much easier to 
see the layout in Print Preview: 

3. Right click on the report tab (or use the arrow below the [View] button)and choose Print Preview  

4. In the Zoom group, click on [Two Pages] 

You’ll find that the information stretches over two pages, with the paper portrait Ńuprightń. It should be 
possible to display all the information on one sideways sheet. To do this: 

5. Right click on the report tab again and this time choose Layout View 

6. Move to the Report Layout Tools Page Setup tab and click on [Landscape]  

You’ll find the report still doesn’t quite fit onto a single page; next, you have to manually shrink the columns:  

7. Position the mouse cursor on the border between the Phone and Warden columns (it becomes a two-

headed arrow) 

8. Hold down the mouse button and drag the border to the left - release the mouse button when the 

column is properly sized  

9. Repeat steps 6 and 7on the other columns until all columns fit on the one page 

10. Repeat step 3 to Print Preview the page  

There are still some problems with the report – Access doesn’t seem to have realised the paper has been 
changed to Landscape (the date and page number are in the wrong position). To rectify this: 

11. Right click on the report tab and choose Design View 

12. Click on the Date placeholder (where it says =Date()) in the Report Header then hold down the <right 

arrow> key to move it to the far right of the page (or drag it to the right with the mouse) 

13. Repeat step 12 for the Time and Page Number placeholders, moving the latter to the centre 

14. Next, click on the Count(*) placeholder in the Report Footer and <Delete> it  

15. Right click on the report tab again and choose Print Preview to check your changes 

16. Finally, close the report (click on the [Close] button) and, when asked, [Save] it as HoR 

With AutoReport, you have no say in the way the report is produced. By using the Report Wizard instead, 
however, you can set various other options (as you found with the Form Wizard). You'll look at this next.  

Using Report Wizards 
To demonstrate the Report Wizard, you are going to produce a report listing the students by their hall of 
residence, with the hall address only appearing once for each group of students. You’ll see how, at each step 
of the wizard, you have control over which fields appear and also over the layout of the report: 
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1. Click on the Addresses query in the Objects list 

2. Move to the Create tab and click on [Report Wizard]  

3. The Report Wizard now goes through six steps:  

a. Move across the fields you want on your report. Here, you just want the FullName and Hall 

(select each in turn then click on [>]) - press <Enter> or click on [Next>]  

b. Step two allows you to set grouping levels. You only need a list of names for each hall, so move 

across Hall (using [>]) then press <Enter> or click on [Next>]  

c. Sort by: FullName (Ascending) - press <Enter> or click on [Next>]  

d. Choose a Layout: Outline is fine - press <Enter> or click on [Next>]  

e. Choose a Style for your report (or, better still, None) - press <Enter> or click on [Next>]  

f. Call your report Addresses - press <Enter> or click on [Finish] 

The resultant report may not be exactly what you want but it's easier to modify the design than to create one 
from scratch.  

4. Right click on the report tab and choose Design View  

5. Widen the FullName field by clicking on the box in the Detail and dragging the right border to the right 

6. Minimise the height of the Detail by positioning the mouse on the border between it and the Page 

Footer and dragging it up a little 

7. Next, click on the [Property Sheet] button – every object on a Report (or Form) has properties 

8. Click on the Hall label on the left and, on the Format tab, set the Visible property to No 

9. Repeat step 8 for the FullName label in the Detail section 

To force each hall onto a separate page:  

10. Click on the Hall Header and set Force New Page to Before Section then [Close] the Property Sheet  

11. Finally, right click and choose Print Preview to see the changes you have made  

12. Click on the window's [Close] button, saving the changes to the design of the report  

Next, try using a special wizard to generate address labels for the students.  

1. Click on the Addresses query in the Objects list 

2. Move to the Create tab and click on [Labels]  

3. The Label Wizard now goes through five steps:  

a. Setup the size for your labels - check Filter by manufacturer: is set to Avery, change the Units of 

Measure to English and select 5160 as the Product number: - press <Enter> or click on [Next>]  

b. Setup the Font name and Font size etc which you require (here leave them as they are) - press 

<Enter> or click on [Next>]  

c. Move the fields across to a Prototype Label by clicking on the arrow provided: 
- move across FullName then press <Enter> 

- move across Hall then press <spacebar> and type Hall - press <Enter> 

- move across Road - press <Enter> 
- move across Town - click on [Next>] 

d. Sort by: Hall and then FullName - press <Enter> or click on [Next>]  

e. Call your report Labels Addresses - press <Enter> or click on [Finish]  

4. Press <Enter> (for [OK]) to cancel the warning message  

5. View the report then click on its [Close] button to close it  

Tip: Getting Access reports looking exactly the way you want can be very time-consuming. It may be easier to 
do the formatting in Excel or Word. On the External Data tab, the [Excel] button lets you send data to an 
Excel spreadsheet, while the [Word] button creates a Rich Text Format (.rtf) file. Using the [More] button you 
can export in various other formats or carry out a mail merge in Microsoft Word. 
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Leaving Access 
You should now be back at the Navigation Pane, where you could continue to work on the students database, 
adding further tables and queries and producing more reports. When you have completely finished your 
work: 

1. Click on the [Office Button] and choose Close Database  

This closes any opened tables etc and ensures that the database file is properly shut down. You could now go 
on to use or create another database, but the course is now over so 

2. Click on the [Office Button] and choose Exit Access 

3. Finally, on the public machines, don't forget to Log Off 

Appendix 
Below is a summary of the different data types and what they are used to store. If you know how a computer 
works then the seemingly random values make sense. For example, the basic storage unit in a computer is a 
byte, which can hold 8 zeros or ones. These, in turn, represent whole numbers between 0 and 255. Two bytes 
can hold 65536 whole numbers (0 to 65535 or -32768 to +32767).  

Data Type Format/Field Size Stores 

Text Up to 255 characters Text - including numeric text (eg phone numbers) 

Memo Up to 65535 characters Longer pieces of text 

Number Long Integer Whole numbers between -2,147,483,648 and +2,147,483,647  

Integer Whole numbers between -32768 and +32767 

Byte Whole positive numbers between 0 and 255 

Single 
38

 

Double 
308

 

Date/Time General Both date & time - eg 25/12/98 16:25:08 

Long/Med/Short Date Dates: eg 25 December 1998 or 25-Dec-98 or 25/12/98 

Long/Med/Short Time Times: eg 16:25:08 or 4:25 (12 hour) or 16:25 (24 hour) 

Currency Currency Up to 15 figures before dec place, 4 after - eg £1,234.56 

Fixed/Standard Numbers with above accuracy - eg 1234.56 or 1,234.56  

Percentage/Scientific Ditto but using % or E notation 

AutoNumber   Automatic counter - incremented by 1 for each record 

Yes/No Yes/No True/False On/Off For data with only 2 possible values 

OLE Object   For pictures, sound, video, Word/Excel documents etc 

Hyperlink   For links to the WWW or e-mail 
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